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Preface

Purpose

Audience

Scope of the
Manual

Other Manuals

S7-PLCSIM is an optional software product for STEP 7 version 3.1. The
S7-PLCSIM software enables you to run and test your program on a
simulated programmable logic controller (PLC) that exists on your computer
or programming device (such as a PG 740). Because the simulation exists
completely within the STEP 7 software, you do not need to be connected to
any S7 hardware (CPU or I/O modules). With the simulated S7 CPU, you can
test and debug programs for both the S7-300 and S7-400 CPUs.

S7-PLCSIM provides a simple interface for monitoring and modifying
different parameters used by the program (such as for turning inputs on and
off). You can also use the various applications of the STEP 7 software while
you are running your program on the simulated CPU. This allows you to use
such tools as the variable table (VAT) to monitor and modify variables.

This manual is intended for engineers, programmers, and maintenance
personnel who have a general knowledge of programmable logic controllers.

This manual describes the features and the operation of S7-PLCSIM version
3.0. In order to install S7-PLCSIM, you must have an authorized version of
STEP 7 version 3.1 installed on your computer.

You can find information in the online help for STEP 7 and for S7-PLCSIM.
In addition, the following manuals provide information about STEP 7.

Title Content

System Software for The System Software f&7-300/S7-400 Program Design
S7-300 and S7-400 Programming Manuaprovides basic information on the
Program Design structure of the operating system and of a user program of
Programming Manual |an S7 CPU.

S7-300 and S7-400 The S7 CPUs have integrated system functions and
System and Standard | organization blocks included with their operating systgm,
Functions Reference |which you can use when programming. This manual
Manual provides you with descriptions of the system functiong
organization blocks, and loadable standard functions
available in S7.

STEP 7 User Manual |TheSTEP 7 User Manuaxplains the main usage and the

functions of the STEP 7 automation software. This mapual
provides you with an overviewf the procedures used td
configure, program, anstart up an S7-300/S7-400 PLQ.

PLC Simulation for S7-300 and S7-400

C79000-G7076-C201-01
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Additional
Assistance

Title

Content

Statement List, Ladder
Logic, STGRAPH
SCL, and FBD
Manuals

The manuals for the programming language packages

Statement List, Ladder Logic, and SCL (Structured Corjtrol
Language) contain both the user’s guide and the referpnce

type.

description of the programming language or representrtion

1 Optional package for system software for S7-300/S7-400

If you have any questions not answered in this or one of the other STEP 7
manuals, if you need information on ordering additional documentation or
equipment, or if you need information on training, please contact your

Siemens distributor or sales office.

PLC Simulation for S7-300 and S7-400

C79000-G7076-C201-01
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Installing the PLC Simulation Software 1

Overview

System
Requirements

Chapter
Overview

The Setup program guides you through the installation of the S7-PLCSIM
software by means of dialogs and menus. You call the Setup program using
the standard Windows 95 software installation procedure.

To install the S7-PLCSIM software, you require the following:

A programming device or PC with the STEP 7 (Release 3.1 or greater)
Standard package already installed, and with the following capabilities:

— 80486 processor (or higher)
— 16 Mbytes RAM

A VGA monitor, keyboard, and mouse which are supported by Microsoft
Windows 95

A hard drive with a memory capacity of 5 Mbytes for the S7-PLCSIM
optional package

At least 1 Mbyte free memory capacity on drive C for the Setup program
(Setup files are deleted when the installation is complete.)

Windows 95 operating system

Section Description Page
1.1 Product Overview
12 Authorization 1-4
1.3 Installing and Uninstalling the S7-PLCSIM Software

PLC Simulation for S7-300 and S7-400

C79000-G7076-C201-01
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Installing the PLC Simulation Software

1.1 Product Overview

Description The S7-PLCSIM software enables you to run and test your program on a
simulated PLC that exists on your computer or programming device (such as
a PG 740). Because the simulation exists completely within the STEP 7
software, you do not need to be connected to any S7 hardware (CPU or I/O
modules). With the simulated S7 CPU, you can test and debug programs for
both the S7-300 and S7-400 CPUs.

S7-PLCSIM provides a simple interface for monitoring and modifying
different parameters used by the program (such as for turning inputs on and
off). You can also use the various applications of the STEP 7 software while
you are running your program on the simulated CPU. This allows you to use
such tools as the variable table (VAT) to monitor and modify variables.

Features S7-PLCSIM offers the following features for running a program on a
simulated PLC:

¢ A button on the SIMATIC Manager toolbar turns the routing to simulation
on or off. With the simulation button turned on, any new connection goes
automatically to the simulated PLC. When the simulation button is turned
off, any new connection goes to the real PLC.

¢ The simulated PLC runs programs intended for either the S7-300 or
S7-400 CPU.

* You can create “view objects” that allow you to access the input and
output memory areas, accumulators, and registers of the simulated CPU.
You can modify any of this data.

¢ You can choose to have the timers run automatically, or you can set or
reset the timers manually.

* You can change the CPU operating mode (STOP, RUN, and RUN-P) as
with a real CPU. In addition, S7-PLCSIM provides a Pause function that
allows you to halt the CPU momentarily without affecting the state of the
program.

S7-PLCSIM also allows you to use all of the STEP 7 tools to monitor and
modify the activities of the simulated PLC.

PLC Simulation for S7-300 and S7-400
1-2 C79000-G7076-C201-01



Installing the PLC Simulation Software

PLC Features The simulated PLC functions as either an S7-300 or S7-400 CPU. It provides
Supported the following capabilities:

e Timers: 512 (T 0to T 511). Timers use a “virtual” clock rather than a
real-time clock. Each timer instruction decrements using a simulation
clock which is based on the instructions executed in the program. Timers
can run faster or slower than real time depending on the size of the
program and the computer hardware used to run the simulation.

Although the timers do not run in real time, they will time out
consistently relative to program execution (even if you use single-scan
program execution or single-step debugging).

e Memory bits: up to 16,384 bits (2048 bytes) of M memory
e |/O memory: up to 16,384 bits (2048 bytes) of /O memory

e Logic blocks and data blocks: 2048 function blocks (FBs) and functions
(FCs), and 2048 data blocks (DBs)

¢ System functions (SFCs): SFC20, SFC21, SFC22, SFC23, SFC26, SFC27,
SFC46, SFC52, and SFC64

For SFC26 and SFC27, the only input parameter supported is 0.

e OBs: OB1 (main program cycle), OB100 (complete restart), and OB101
(restart)

Limitations of the S7-PLCSIM has the following limitations:
Simulated PLC e You can run only one simulated PLC at a time.
e The simulated PLC does not support all of the error messages written to
the diagnostic buffer. It supports only the information available from the
RUN mode transitions. It also supports diagnostics of fatal errors and
time-out events, such as infinite loops.

e System data blocks (SDBs) are downloaded with your program, but are
ignored by the simulated PLC.

Differences The simulated PLC provides the following capabilities which are not
between a available in a real PLC:
Simulated PLC

and a Real PLC ¢ The Pause function halts the simulated CPU and allows you to resume the

execution of the program at the instruction where the program was halted.

* Any change that you make with a view object immediately updates the
contents of the memory location. The CPU does not wait until the
beginning or the end of the scan to update any changed data.

e Execution options allow you to select how the CPU runs the program:

— Single Scan executes the program for one scan and then waits for you
to start the next scan.

— Continuous Scan executes the program like a real PLC: it starts a new
scan immediately after the previous one finishes.

e Using STOP mode does not change the state of the outputs (PQ).

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01 1-3



Installing the PLC Simulation Software

1.2 Authorization

Overview

Authorization Disk

/N

Installing the
Authorization for
the First Time

1-4

The S7-PLCSIM programming software requires a product-specific
authorization (or license for use). The software is therefore copy-protected
and can be used only if the relevant authorization for the program or software
package has been found on the hard disk of the respective programming
device or PC.

A read-only authorization disk is included with the software. It contains the
authorization and the program required to display, install, and remove the
authorization called AUTHORS.

For more information and rules on how to handle authorizations, see the
STEP 7 User Manual

Caution

Note the information in the README.TXT file on the authorization disk. If
you do not adhere to these guidelines, the authorization may be irretrievably
lost.

When installing your software for the first time, a message prompts you to
install the authorization. Follow the steps outlined below:

1. When prompted, insert the authorization disk in a drive.
2. Acknowledge the prompt.

The authorization is transferred to a physical drive and your computer
registers the fact that the authorization has been installed.

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01



Installing the PLC Simulation Software

Adding an If you attempt to start the S7-PLCSIM software and there is no authorization
Authorization at a available for the software, a message informs you of this. If you want to
Later Date install the authorization, use the AUTHORS program on the authorization

disk. This program allows you to display, install, and remove authorizations.
The program is menu-driven.

Note
Always enter drive C as the destination drive for the authorization for
S7-PLCSIM.
Removing an If you should need to repeat the authorization, for example, if you want to
Authorization reformat the drive on which the authorization is located, you must remove

the authorization first. You need the original authorization disk to do this.

To transfer the authorization back to the authorization disk, follow the steps
outlined below:

1. Insert the original authorization disk in your floppy disk drive.

2. Start the program AUTHORS.EXE from the authorization disk.
3. Select the menu commaAdthorization » Remove
4

. In the dialog box, enter the drive on which the authorization is located
and confirm the dialog box. A list of all authorizations on the respective
drive is displayed.

5. Select the authorization you want to remove and confirm the dialog box.
If the process is completed without error, the following message appears:
" Authorization <Name>successfully removed from drive<X:>.”

6. Acknowledge the message.

The dialog box with the list of authorizations remaining on the drive is
then displayed. Close the dialog box if you do not want to remove any
more authorizations.

You can then use the disk again to install an authorization.

If Your Hard Drive If a fault occurs on your hard disk before you can back up the authorization,
is Defective... contact your local Siemens representative.

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01 1-5



Installing the PLC Simulation Software

1.3 Installing and Uninstalling the S7-PLCSIM Software

Overview

Preparing for

Installation

Starting the
Installation
Program

If a Version of
S7-PLCSIM is
Already Installed

Uninstalling

1-6

S7-PLCSIM includes a Setup program which executes the installation
automatically. Prompts on the screen guide you step by step through the
installation procedure.

Before you can start installing the software, Windows 95 must be started and
the STEP 7 basic package loaded.

The Setup program guides you step by step through the installation process.
You can switch to the next step or to the previous step from any position. To
start the installation program, proceed as follows:

1. Start the dialog box for installing software under Windows 95 by
double-clicking on the Add/Remove Programs icon in the Control Panel.

2. Click on “Install...”

3. Insert disk 1 and click on “Next.” Windows 95 searches automatically for
the installation program SETUP.EXE.

4. Follow the instructions displayed by the installation program step by step.

If the installation program finds another version of S7-PLCSIM on the
programming device, the program reports this and prompts you to decide
how to proceed by offering the following choices:

e Abort the installation so that you can uninstall the old S7-PLCSIM
version under Windows 95 and then start the installation again.

e Continue the installation and overwrite the old version with the new
version.

Your software is better organized if you uninstall any older versions before
installing the new version. Overwriting an old version with a new version has
the disadvantage that if you then uninstall, any remaining components of the
old version are not removed.

During installation, queries are shown in dialog boxes for you to answer, and
options are displayed for you to select. Read the following notes so you can
reply to the queries faster and more easily.

Use the usual Windows 95 procedure to uninstall:

1. Start the dialog box for installing software under Windows 95 by
double-clicking on the Add/Remove Programs icon in the Control Panel.

2. Select the SIMATIC S7-PLCSIM entry in the displayed list of installed
software. Click on the “Add/Remove..."” button to uninstall the software.

3. If the “Remove Enable File” dialog boxes appear, click the “No” button if
you are unsure how to respond.

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01



Installing the PLC Simulation Software

Using the Scope of
Installation

Using
Authorization

Result of the
Installation

If Errors Occur
during the
Installation

All languages of the user interface and all examples require approximately
5 Mbytes of memory capacity.

During installation, the program checks to see whether an authorization is
installed on the hard disk. If no authorization is found, a message appears
that the software can be used only with an authorization. If you wish, you can
run the authorization program immediately or continue the installation and
execute the authorization at a later date.

In the first case, insert the authorization disk when you are prompted to do
so. (See Sectign 1.2.)

Once the installation has been completed successfully, a message to that
effect is displayed on the screen.

The following errors may cause the installation to fail:

¢ [|nitialization error immediately after starting Setup: The SETUP.EXE
program was probably not started under Windows 95.

¢ Not enough memory: You need at least 5 Mbytes of free space on your
hard disk.

¢ Bad disk: Verify that the disk is bad, then call your local Siemens
representative.

e Operator error: Start the installation again and read the instructions
carefully.

PLC Simulation for S7-300 and S7-400
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Getting Started with S7-PLCSIM 2

Overview STEP 7 provides a sample program called “S7_ZEBRA”. You can use this
program to become familiar with the features of the S7-PLCSIM software.

This chapter provides the basic steps for downloading and running the
program on a simulated CPU. It also provides information about using the
different view objects and a variable table (VAT) with the simulation.

Chapter Section Description Page
Overview 2.1 Downloading the Sample Program to the Simulated PLC

2.2 Setting Up the Simulated PLC

2.3 Running the Sample Program 2-4

2.4 Using STEP 7 Tools to Monitor the Program
PLC Simulation for S7-300 and S7-400 2.1
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Getting Started with S7-PLCSIM

2.1 Downloading the Sample Program to the Simulated PLC

Selecting and
Downloading the
Program

2-2

STEP 7 provides a sample program that you can download to the simulated
PLC. Use the following procedure to download the sample program:

1.
2.

Start the SIMATIC Manager.

Turn on the routing to the simulator by clicking on the Simulation On/Off
button located on the SIMATIC Manager toolbar, as shown in Figure 2-1,
or by selecting the menu comma@gtions » Simulate Modules

Use the SIMATIC Manager menu commadtilg » Open» Project to
open the S7_ZEBRA project. This project is supplied with the STEP 7
software.

Navigate through the object hierarchy until you get to the blocks object.
Figure 2-1 shows the S7_ZEBRA project structure.

. Select the menu commaRdC » Download or click on the download

button to download the blocks object to the simulated CPU.
(Downloading the blocks automatically creates the simulated CPU.)

The S7-PLCSIM application window opens with a default CPU view object.
The Windows taskbar displays an icon to alert you that there is a simulated
PLC. (If you place the mouse cursor on the icon, a tool tip displays the MPI
number.)

SIMATIC Manager - S7_ZEBRA
File Edit Insert PLC View Options Window Help

Download button

Simulation On/Off button

blocks object

Press F1 for Help [NUM | | %

Figure 2-1 Downloading the S7_ZEBRA Program to the Simulated PLC

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01



Getting Started with S7-PLCSIM

2.2  Setting Up the Simulated PLC

Creating View
Objects for the
Sample Program

The S7_ZEBRA sample program uses several inputs, outputs and timers. You
can use a view object to turn the inputs on and off, and you can watch the
timer values and outputs change as the program runs. Figure 2-2 shows the
view objects used with the sample program. Use the following procedure to
create the different view objects:

1. Create a view object that accesses the inputs used by the program:
— Select the menu commahtsert » Input Variable .

— The default value iBIBO (for peripheral input byte 0). PreéSNTER
to accept.

2. Create a view object that accesses the outputs used by the program:
— Select the menu commahtsert » Output Variable.

— The default value iBQBO (for peripheral output byte 0). Pr&ssTER
to accept.

3. Create three view objects to access the timers used by the program:
— Select the menu commahtsert » Timer.

— The default value is T 0, with the 0 highlighted. TZpi@ the view
object (for Timer T 2) and preENTER.

— Repeat for timers T3and T 4.

[E] PLC Simulation — Zebra.plc
Simulation Edit Insert PLC Execute View Options Window Help

[ JRUN

N EEEE

[ ISF [ RuNn-P
Il DC [ RUN

[ STOP [V STOP MRES

T EWE]

Ready | [NUM | 4
Figure 2-2  View Objects for the S7_ZEBRA Sample Program
PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01 2-3



Getting Started with S7-PLCSIM

2.3

Selecting the
Execution Option

Running the Sample Program

With the sample program downloaded to the CPU, you can now run the
program. Before starting the program, ensure that the program execution is

set for continuous scan. Use the menu comnixetute> Mode »
Continuous Scanor click on the toolbar button (shown in Figure 2-3) to
select the execution control option for running the program continuously.

‘ T [E

!

]

Click here for Continuous Scan program execution.

Figure 2-3 Selecting Continuous Scan Program Execution

Starting the
Program

Use the following procedure to switch the CPU into RUN mode and to start
the program.

1. Click the RUN check box in the CPU view object. See Figure 2-4.

[ CPU 300/400 EEB{

ESF [~ RUN-P
DC
B RUN [@%RUN -

[ ISTOP[ | STOP MRES

| Click here to switch
CPU to RUN mode.

Figure 2-4  Selecting RUN Mode

2. Click either bit O or bit 1 in the Input Variable view object to turn on
P10.0 or P10.1, as shown in Figure 2-5.

EPB 0 EEE

PIB 0

| Bits

7 6 5 4 3 21

(o

fo b

Click here to turn on
input bit P10.0.

Figure 2-5 Turning on Input PI0.0

2-4

PLC Simulation for S7-300 and S7-400
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Getting Started with S7-PLCSIM

In the view objects, you can watch the timer values as they change and the
outputs as they turn on or off, as shown in Figure 2-6. As each timer reaches
its preset value, the corresponding outputs turn on or off.

To speed up the operation of the sample program, you can reset the timers in
turn by clicking on the “T = 0” button in the Timer view objects.

Saving the Layout You can save your layout of view objects within the simulated PLC window

of View Objects by selecting the menu comma8ianulation » Layout Save... You can then
retrieve the saved layout at any time by selecting the menu command
Simulation » Layout Open...

[El PLC Simulation — Zebra.plc
Simulation Edit Insert PLC Execute View Options Window Help

T = s e s i o e T

[ ISF [~ Run-P

DC
==, oo

[ ]STOP[ | STOP MRES

—

Ready | [NUM | v

Figure 2-6 Sample View Objects Showing Status in RUN Mode

PLC Simulation for S7-300 and S7-400
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2.4 Using STEP 7 Tools to Monitor the Program

Using a Variable STEP 7 allows you to use a variable table (VAT) to monitor the status of any
Table to Monitor or variable in your program. Figure 2-7 shows a VAT for the sample program.
Modify Data You can also modify the variables which are defined for the VAT. To monitor

program status using the variable table, follow these steps:
1. Access the SIMATIC Manager window.

2. Select VAT1 and double-click with the mouse or use the menu command
Edit » Open Objectto open the variable table for the “S7_ZEBRA”
project.

3. Select the menu commaRdC » Connect To> Configured PLC to
establish an online connection with the program in the simulated PLC.

You can now observe the values of the input, output, and timer elements in
the Monitor Value column of the VAT, as shown in Figure 2-7.

S7_ZEBRA\SIMATIC 300-Station1\CPU314(1)\S7—Program(1)\...\VAT1
|Address |Symbo| |Monitor Format |Monitor Value |ModinyaIue
Q 0.1 | “Ped_green” [BIN [ 2#0 | —— Al
Q 0.5 | “Car_red” | BIN | 2#0 [——
Q 0.6 | “Car_orange” [BIN [ 2#1 [——
Q 0.7 | “Car_green” [BIN [ 2#0 [—
T 4 | “Car_delay_red” [ SIMATIC_TIME | S5T#4s820ms | S5T#0ms
T 5 |“Car_red_orange_phase” | SIMATIC_TIME | S5T#0ms | S5T#0MS —
T 6 |“Ped_delay_green” | SIMATIC_TIME | S5T#0ms | S5T#OMS
[ 0.0 | “Switch_right” [BIN [ 2#1 [ 2#1
[ 0.1 | “Switch_left” [BIN [ 2#0 [2#1
[
« | uZ

Figure 2-7 Example of a STEP 7 Variable Table (VAT)

PLC Simulation for S7-300 and S7-400
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Getting Started with S7-PLCSIM

Using the Program To view the execution of program logic in the ladder view of the program,
Editor to Monitor follow these steps:
Status

1. Access the SIMATIC Manager window.

2. Select FC1 in the online view and double-click with the mouse or use the
menu commanédit » Open Objectto open the program for the
“S7_ZEBRA” project.

If necessary, seledtiew » LAD in the LAD/STL/FBD application to
switch from the statement list view to the ladder view.

3. Select the menu commabébug®> Monitor to enable the animation of
program execution in the ladder networks.

You can now observe the power flow to the inputs, outputs, memory bits, and
timer elements in the ladder networks, as shown in Figure 2-8.

LAD/STL/FDB — [S7_ZEBRA\SIMATIC 300-STATION(1)\CPU 314(1)\...\ - [FC1 - <On-line>] !E n
. - . Al
NEVTe] ¢l : Determining green request for pedestrians
Determining whether 1 0.0 or | 0.1 is set J
IOI.q 'II'6 'II'S I\/}0.0
I | l__ /{ \ )_
10.1
| ]
I
MO0.0
| |
11
Network 2 : Green phase for cars
If 10.0 or 1 0.1 are not set, the light stays green for cars.
MO.0 Q0.7
% (-
=l
<_| nZ

Figure 2-8 Monitoring Program Status in the Ladder View
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Running a Program on the Simulated PLC

Overview S7-PLCSIM works with the STEP 7 software to test and debug your program
on a simulated PLC. This chapter describes how to start the PLC simulation,
download a program, select execution options, and access data in the
program.

Chapter Section Description Page
Overview

3.1 Starting the PLC Simulation

3.2 Downloading a Program to the Simulated PLC

3.3 Selecting the Simulator Options

3.4 Accessing Data in the Simulated PLC

35 Opening, Saving, and Closing the Simulated PLC

PLC Simulation for S7-300 and S7-400
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Running a Program on the Simulated PLC

3.1 Starting the PLC Simulation

You use the SIMATIC Manager to determine whether a program that you
download will go to a real PLC or to a simulated PLC.

Selecting STEP 7 provides a button on the SIMATIC Manager toolbar that turns the
Simulation routing to S7-PLCSIM on or off. With the simulation button turned on, any
new request for an online CPU connection is re-routed to a simulated CPU.

Be aware, however, that selecting simulation does not close any online
connections that you may have with a real PLC. Because of the risk of
unintentionally editing a real online program, you cannot start a simulation
session until you close all windows or applications that are connected to real
PLCs.

Figure 3-1 shows the SIMATIC Manager window with the Simulation On/Off
button.

Note

You can have only one simulated PLC active at a time. When the Simulation
On/Off button is turned on, clicking on the Accessible Nodes button shows
the node address for the simulated CPU that you have created. When the
Simulation On/Off button is turned off, the Accessible Nodes window shows
the network of real PLCs.

SIMATIC Manager - S7_ZEBRA
File Edit Insert PLC View Options Window Help

Dl=lg|=] olsle] &l & 2=

SIMATIC 300-Station(1)
ZF MPI-Net(1)

& Blocks Simulation On/Off button

Accessible Nodes button

Press F1 for Help [NUM | | /

Figure 3-1 Selecting PLC Simulation with the SIMATIC Manager

PLC Simulation for S7-300 and S7-400
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Running a Program on the Simulated PLC

3.2 Downloading a Program to the Simulated PLC

S7-PLCSIM starts when you download a program to the simulated PLC.
STEP 7 provides two options for downloading a program:

* You can download an existing program with the SIMATIC Manager.
¢ You can download your program from the program editor.

After you download your program, an icon appears in the Windows taskbar to
inform you that there is an active connection to the simulated PLC.

For more information about downloading programs, refer t&WEP 7 User

Manual
SIMATIC Manager Program Editor
P2 SIMATIC Manager - S7_ZEBRA
Eile Edit Insert ch View Options Window Help EE
02|Ez] olzle| dl Wl 2w @) | Network 1 :
&) S7_ZEBRA - <Offline> (Project) | J
ZEBRA SIMATIC 300-Station(1)
B 1C 300-Station(1) B \pI-Netz(1) } it # {—
@ CPU314(1)
EE S7-Program(1)
@ Source Files
-3 Blocks
ork 2
(—
=|
27
Press F1 for Help
S7-PLCSIM
PLC Simulation — SimView1
Al CPU 300/400 -] x]
W SF[7 rRun-pP
= zﬁN 7 run
[l sToP[T STOP MRES
Figure 3-2  Options for Downloading a Program to the Simulated PLC
PLC Simulation for S7-300 and S7-400 3.3
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Running a Program on the Simulated PLC

3.3 Selecting Simulation Options

Selecting
Execution Options

Using the Pause
Function

Cycling Power
On and Off

3-4

You select the program execution options withERecutemenu commands.
You can also access these options with the toolbar buttons, as shown in
Figure 3-3. These options control the execution of the program:

¢ Continuous Scan: The CPU executes one complete scan and then starts
another scan. Each scan consists of the CPU reading the peripheral inputs
(PI), executing the program, and then writing the results to the peripheral
outputs (PQ).

¢ Single Scan: The CPU executes one scan and then waits for you to initiate
another scan. Each scan consists of the CPU reading the peripheral inputs
(PI), executing the program, and then writing the results to the peripheral
outputs (PQ).

The Pause function allows you to halt the execution of a program
temporarily. Unlike placing the CPU into STOP mode (which restarts the
execution of the program at the first instruction in your program when you
return to RUN mode), halting the execution of a program lets you resume the
execution at the instruction where you halted the program.

You can turn the Pause function on and off withERecute» Pausemenu
command, or you can use the toolbar button, as shown in Figure 3-3.

You can simulate turning power on and off for the CPU. This allows you to
check the different startup OBs. Use BieC » Power Off/Power Onmenu
commands to cycle power. (You must turn the power on before you change
the node address for the CPU.)

S7-PLCSIM ‘ I]IIT} Il ‘

Toolbar
T X\

Next Scan
Single Scan Pause

Continuous Scan

Figure 3-3 Toolbar Buttons for Program Execution Options
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Running a Program on the Simulated PLC

3.4  Accessing Data in the Simulated PLC

Overview

Using the
S7-PLCSIM
View Objects

You can access data in the simulated PLC with the “view objects” provided
by the main S7-PLCSIM window, or with the standard STEP 7 tools for
monitoring program status, or a combination of both.

View objects allow you to monitor the program by displaying the values or
the states of the variables used by the program. Some view objects are
read-only; others allow you to change the values of specific memory
locations. S7-PLCSIM provides view objects for the following types of data:

e \Variable data. This view object allows you to display or modify the values
of timers, counters, I/O bits, or other memory locations.

The following view objects can provide useful information for debugging a
program when used with the breakpoint function in STEP 7:

e Accumulators and the status word. The read-only “ACCUs & Status
Word” view object accesses the contents of the accumulators and the
values stored in the pointer address registers (AR1 and AR2). It also
displays the states of the status word bits.

e Block registers. The read-only “Block Regs” view object accesses the
contents of the data block address registers (DB1 and DB2). It also
displays the identity of the logic block being executed and the step
address counter (SAC).

* Stacks (nesting stack and MCR stack). The read-only “Stacks” view
object accesses the contents of the nesting stack, which consists of the
RLO bit and the OR bit of the status word. (The nesting stack shows the
state of the status word for each instruction in the logic string.) This view
object also shows the state of the MCR (master control relay) stack.

There is no restriction on the number of view objects that you can create and
display. For more information on using view objects, see C@ter 4.

N

Create “Stacks” Create “Block Regs”

view object view object
Create “Variable” Create “ACCUs
view object & Status Word”
view object

Figure 3-4 Toolbar Buttons for Creating View Objects
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Running a Program on the Simulated PLC

Using the STEP 7
Tools

Using a Variable
Table to Monitor or
Modify Data

3-6

You can use the STEP 7 tools to monitor and modify the program that is
being executed by the simulated CPU. This allows you to create and test a
variable table (VAT) or to use the debugging tools provided by STEP 7. For
more information about the STEP 7 tools, seeSS(hEP 7 User Manuair the
manual for your programming language.

Remember to disconnect any STEP 7 tool before closing the simulated CPU
or exiting the S7-PLCSIM application.

Note

Using the Pause function can cause the STEP 7 tools to disconnect from the
simulated PLC because of a time-out while STEP 7 waits for a request to be
acknowledged. After you turn Pause off, you can reconnect the STEP 7 tool.

You can use a variable table (VAT) to monitor the status of any variable in
your program. You can also modify the variables which are defined for the
VAT. You can use the simulated CPU to test a VAT that is being prepared as
an interface. Figure 3-5 shows a sample VAT for the S7_ZEBRA program.

S7_ZEBRA\SIMATIC 300-Station1\CPU314(1)\S7—Program(1)...\VAT1 ™=l B3
Address Symbol Monitor Format Monitor Value | Modify Value
[ Q 0.1 | “Ped_green” | BIN | [——- | =
Q 0.5 | “Car_red” | BIN | [——
Q 0.6 | “Car_orange” | BIN | [——
Q 0.7 | “Car_green” | BIN | [-—-
T 4 | “car_delay_red” | SIMATIC_TIME | | s5T#Oms
5 | “Car_red_orange_phase” | SIMATIC_TIME | | s5T#Oms —
6 | “Ped_delay_green | SIMATIC_TIME | | s5T#Oms
[ 0.0 | “Switch_right” | BIN | [ 2#1
[ 0.1 | “Switch_left” | BIN | [ 2#1
=l
Kl | a7

Figure 3-5 Example of a STEP 7 Variable Table (VAT)
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Running a Program on the Simulated PLC

3.5 Opening, Saving, and Closing the Simulated PLC

Opening a
Simulated PLC

Saving the
Configuration of a
Simulated PLC

Saving the Layout
of View Objects

Closing the
Simulated PLC

You can open a simulated PLC in one of the following ways:

e With the Simulation On/Off button on, you can download a program from
the SIMATIC Manager or the program editor.

¢ If you have already saved one or more simulated PLCs to a file, you can
open a specific PLC by using tBémulation » Open menu command.

Note
S7-PLCSIM supports only one simulated PLC at a time.

Use theSimulation » Saveor Simulation » Save As..menu command to
archive a simulated PLC. The following elements are saved with the PLC:

* Program

e CPU operating mode (RUN-P, RUN, or STOP)

e Power state (on or off)

e Execution control option (continuous scan or single scan)
* The status of the I/0O (Pl and PQ memory areas)

e Timer values

To save the layout of the view objects you have inserted for the simulated
PLC, select the menu commaS8inulation » Layout Save... Any time you
reopen a saved simulated PLC, you can also open a saved layout using the
Simulation » Layout Open...menu command.

You can close a PLC either by selecting $irulation » Closemenu

command or by clicking on the button in the top-right corner of the CPU
view object. Closing the simulated PLC ends the simulation of the program,
but does not exit the S7-PLCSIM application.

PLC Simulation for S7-300 and S7-400
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Monitoring and Modifying Data with the

View Objects

Overview

Chapter
Overview

information:

¢ \Variable data, such as timers, counters, inputs, and outputs

e Accumulators and status word

e Address registers

* Nesting stack and MCR stack

Any change made by a view object affects the program immediately. When

A

S7-PLCSIM provides view objects that allow you to display the following

you use a STEP 7 variable table to change a value, the CPU reads that
change at the beginning of the next scan.

Section Description Page
4.1 Controlling the CPU @
4.2 Monitoring and Modifying the Data Used by the @

Program
4.3 Displaying the Symbolic Addresses @
4.4 Accessing the Accumulators, Status Word, and Address [4-7
Registers
4.5 Monitoring the Block Registers @
4.6 Monitoring the Data in the CPU Stacks k-4
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Monitoring and Modifying Data with the View Objects

4.1  Controlling the CPU

Using the CPU After you download a program, the S7-PLCSIM application window displays

View Object a CPU view object that has the same node address as the downloaded
program. Figure 4-1 shows a sample CPU view object. From this view object,
you can perform the following functions:

¢ Change the CPU operating mode (STOP, RUN, and RUN-P)
¢ Reset the CPU memory (MRES)

Displaying the A real CPU provides LED indicators for displaying the status of the CPU.
Status of the CPU The CPU view object also provides the following indicators that display the
CPU status:

¢ SF (system fault) indicates an error condition.

¢ DC (power supply) indicates that power to the CPU is on.
* RUN indicates that the CPU is in RUN mode.

e STOP indicates that the CPU is in STOP mode.

For more information about the S7-300 and S7-400 CPUs, refer &ystem
Software for S7-300 and S7-400 Program Design Programming Mantal
the online help for STEP 7.

[ cpusoosoo [ T SN operating

E SF RUN-P mode controls
DC
Il RUN [ RuN

Bl STOP[ | STOP MRES

CPU status
indicators

Figure 4-1 CPU View Object
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Monitoring and Modifying Data with the View Objects

Changing the CPU
Operating Mode

Resetting the CPU
Memory (MRES)

The check boxes on the CPU view object allow you to change the CPU
operating modes:

e In STOP mode, the CPU is not executing the program. To download a
program that includes SDBs or to change the node address, you must
place the CPU in STOP mode. Unlike a real CPU, placing the CPU in
STOP mode does not change the state of the outputs (PQ).

¢ In RUN mode, the CPU executes the program. As with a real CPU, you
cannot download any new programs or logic blocks when the CPU is in
RUN mode. You can use the STEP 7 tools to monitor (but not to modify)
the variables.

* In RUN-P mode, the CPU executes the program. When the CPU is in
RUN-P mode, you can download new programs or logic blocks, and you
can modify the variables with the STEP 7 tools.

To change the CPU mode, click on the box for STOP, RUN, or RUN-P. The
CPU status indicators show whether the CPU is in RUN (or RUN-P) mode or
in STOP mode.

The CPU view object provides an MRES button for resetting the memory of
the CPU. When you reset the CPU memory, the simulated CPU performs the
following tasks:

* The memory areas are reset.

* The program blocks are deleted.

Use the following procedure to reset the CPU memory:
1. Place the CPU in STOP mode.

2. Click on the MRES button, or select the menu command
PLC » Clear/Reset

PLC Simulation for S7-300 and S7-400
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Monitoring and Modifying Data with the View Objects

4.2  Monitoring and Modifying the Data Used by the Program

Accessing the
Data Stored in the
CPU Memory

You can create view objects that access the data stored in the different
memory areas of the simulated CPU. S7-PLCSIM provides view objects that
contain default addresses for a timer, a counter, an input, and an output. You
can also create a generic view object to access the data stored in other
memory areas.

The view objects that you create with theert menu commands allow you

not only to display the contents of the different memory areas within the
CPU, but also to modify those values and immediately see the effect on your
program. When you change a value in a data field, EeSER for it to be
accepted.

You can use these view objects to access not only the inputs and outputs, but
also the timers, counters, and the data used by the program. Table 4-1 lists
the memory areas that can be accessed.

For more information about the memory areas, refer t&ylséem Software
for S7-300 and S7-400 Program Design Programming Maoutd the
online help for STEP 7.

Note

The peripheral input (PlI) memory area overwrites the input (I) memory area
at the beginning of every CPU scan. If you use the view object to modify a
value in the | memory area, that value is overwritten at the beginning of the
next scan. To enter an input value that will not be overwritten on every scan,
enter the value to the Pl memory area.

Table 4-1 Memory Areas for the S7-300 and S7-400 CPUs

Memory Area

Description

Pl peripheral (external)

input, The CPU writes the Pl memory to the | memory at the beginning of each gcan.

PQ peripheral (external) outpuiThe CPU writes the Q memory to the PQ memory at the end of every scaf.

| process-image input

The | memory area is overwritten by the Pl memory area at the beginning|of
every scan.

Q process-image output The Q memory area overwrites the PQ memory area at the end of each sgan.

M bit memory

The M memory area provides storage for interim results calculated in the

program.
T timer The T memory area provides the timers used by the program.
C counter The C memory area provides the counters used by the program.

DB data block

The DB memory address references the data stored in the data blocks foil the
program.

4-4
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Monitoring and Modifying Data with the View Objects

Creating View
Objects for
Accessing
Program Data

Using the View

Objects to
Modify Data

To create view objects for monitoring and modifying the data used by the
program, use thimsert menu commands. Figure 4-2 shows several examples
of the view objects. Use the following procedure to access a memory address
with a view object:

1. Enter the memory address to be accessed andEN€ER For example:
“PIB0” accesses byte 0 of the PI memory area and “T 2” accesses timer 2.

2. Use the drop-down list box to select the appropriate representation for the
data that will be displayed or entered (such as binary, decimal, or

hexadecimal).

BEPB 0 !Eﬂ

BT o2 EEE|

BEPrw o

|Pw 0

L

|| Decimal |v

|| 0

Figure 4-2 Variable View Objects

Use the following guidelines to modify data in the view objects:

When you select bit format for a variable such as a peripheral input byte,
the eight check boxes correspond to bits 0 through 7. To activate any of
the bits in the view object, click on the corresponding check box to
change the state from off to on (0 to 1). A check mark appears, indicating
a state of 1 or on. Clear the check box to turn the bit off.

For variables that you specify as bytes, words, or double words, use the
drop-down list box to select the appropriate representation for the data
that you want to enter (such as binary, decimal, or hexadecimal). Enter
the value in the text field in the corresponding format and ENSER

PLC Simulation for S7-300 and S7-400

C79000-G7076-C201-01

4-5



Monitoring and Modifying Data with the View Objects

4.3 Displaying the Symbolic Addresses

Selecting the
Symbol Table

Showing Symbol
Names in View
Objects

4-6

You can display the symbol names assigned to the absolute addresses in any

of the view objects of your simulated PLC. To establish a link to the symbol
table associated with the downloaded program, follow these steps:

1. Select the menu comma@gbtions» Show Symbols...

2. Use the browser dialog box to select the symbol table associated with the

downloaded program.

3. Click on the “OK” button to confirm the selection.

To show the symbol name associated with an element in your program,

follow these steps:

1. Select the view object of a variable that you want to display with its

symbol name.

2. With the cursor in the address field, click the right mouse button to open a

pop-up menu.

3. SelectShow Symbolfrom the menu. (If there is no symbol name
associated with the variable, Show Symbol is unavailable.)

You can point to any address that has a symbol hame associated with it and
see the full symbol name in a tool tip. For bits of a byte address, the only way

to see the symbol nhames is to display the tool tip for each bit check box.

Figure 4-3 shows examples of view objects with the symbol names displayed

in the address field. Note that the absolute address is still displayed in the

title bar of the view object.

Undo
Click the right | =S I,
mouse button. Cut
0.1| Copy
7 6 5 4 FPaste
COCCC Delete
Select All
Select — [J Show Symbol

BQ o1 [ x]

|| Ped_green || Bits ]

7 6 5 4 3 210

COCOEC OCoCO

BT 4

Car_delay_red
Oms ' T=0

Figure 4-3 Showing Symbol Names for Program Elements
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Monitoring and Modifying Data with the View Objects

4.4  Accessing the Accumulators, Status Word, and Address Registers

You can display the contents of the accumulators, the status word, and the
address registers in the CPU by opening the “ACCUs & Status Word” view
object. Select the menu commavidw » Accumulators to open this view
object.

Figure 4-4 shows the “ACCUs & Status Word” view object.

For more information about the status word and the accumulators for the
S7-300 and S7-400 CPUs, refer to 8ystem Software for S7-300 and
S7-400 Program Design Programming Manoalo the online help for

STEP 7.
ACCUs & Status Word =[] x| |
— Accumulators ~ Status Word
1] 100 8 E BR
(¢) Dec 7[cca
2[00 6 []cco
3]0 5[ ov
(" Hex
4o 4 [ o0s
— Address Registers — ? E ol
1[0 2 [ sTA
1 [ RLO
20 0 [ I/FC

Figure 4-4  Accumulators and Status Word View Object
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Monitoring and Modifying Data with the View Objects

4.5 Monitoring the Block Registers

Displaying the
Contents of the
Block Registers

4-8

You can view the contents of the data and logic block registers by opening
the “Block Regs” view object. Select the menu commidiesy » Block
Registersto open this view object.

Figure 4-5 shows the “Block Regs” view object.

For more information about the block registers for the S7-300 and S7-400
CPUs, refer to th8ystem Software for S7-300 and S7-400 Program Design
Programming Manuabr to the online help for STEP 7.

IA Block Regs = B3 |

Data Block
1o

2|0

Logic Block SAC
1@ 1 [16

2]jo lo

Figure 4-5 Block Registers View Object
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Monitoring and Modifying Data with the View Objects

4.6  Monitoring the Data in the CPU Stacks

Monitoring the The “Stacks” view object displays the status of both the nesting stack and the
Nesting Stack and master control relay (MCR) stack. These stacks help you to monitor the state
the MCR Stack changes of individual instructions in your program:

* The nesting stack stores up to seven entries. For each entry, the nesting
stack stores the states of the RLO and OR bits of the status word for the
And (A), And Not (AN), Or (O), Or Not (ON), Exclusive Or (X), and
Exclusive Or Not (XN) instructions.

e The MCR stack stores up to eight levels of nesting for an MCR.

To create the view object for viewing the nesting stack and the MCR stack,
use theview » Stacksmenu command.

Figure 4-6 shows the “Stacks” view object. Refer toSteement List (STL)
for S7-300 and S7-400 Programming Manfaalmore information about the
nesting stack and the MCR stack.

— Nesting Stack ~ MCR
[ MAbit RLO
RLO OR
Aalln e
2 E E ZE
3 E E 3E
4 [0 O a7
50 [T 5[
6 E E GE

Figure 4-6  Stacks View Object
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Troubleshooting

Table A-1 Troubleshooting

Problem

Possible Cause

Your program does not download to th
simulated PLC.

eVerify that the CPU is in either STOP mode or RUN-P mode.

As with a real CPU, you cannot download your program if the simu
CPU is in RUN mode. Also, you cannot download your program w|
the simulated CPU is in Pause mode.

ated
hen

CPU is in STOP mode.

If your program contains an SDB, verify that the CPU is in STOP n
As with a real CPU, you can download SDBs only when the simulg

ode.
ted

Verify that the CPU and the program use the same node address.

must match the node address of the CPU.
When you download a program and there is no simulated PLC con

address for the program, STEP 7 displays an error message.

to STEP 7, S7-PLCSIM creates a simulated PLC with the correct n
address for the program; however, if there is already a simulated F
connected to STEP 7 and the node address does not match the ng

As with a real MPI network, the node address defined for the progfam

ected
ode
LC
de

When you attempt to close the simula
PLC, a message alerts you that there
connection open.

dflyou attempt to close the simulated PLC while one of the STEP 7
qsuch as a variable table) is monitoring the program, STEP 7 alerts

by closing the tool before closing the simulated PLC.

tools
you to

disconnect the STEP 7 tool from the simulated PLC. Always disconnect
any STEP 7 tool by turning off the monitoring of the program statug

or

You enter an input value for the
simulated PLC, but this value is
overwritten.

If you want the input value to remain from one scan to the next, us
peripheral input (Pl) memory area instead of the input memory are

As with a real CPU, the simulated CPU writes the state of the proc
image (containing the peripheral input memory) to the input memo
area. Even though there are no input modules in the simulated PL

memory. The input (I) memory area is always overwritten by the Pl
memory at the beginning of every scan.

process image contains “data” (a value of 0) that corresponds to th

e the

T
y

C, the
e Pl

The S7-PLCSIM application does not
respond and appears to have “locked

First, check to see if Single Scan execution control or the Pause fu
[is"on. Either one can appear as a lock-up. Turn off Pause, or selec|
Continuous Scan mode.

Ctrl+Alt+Del keys simultaneously, and end the S7-PLCSIM applica

If the software does not respond to one of the actions above, press

hction

the
ion.

PLC Simulation for S7-300 and S7-400
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S7 Reference Information B

Overview

Chapter
Overview

S7-PLCSIM provides view objects for accessing the information stored in the
simulated CPU. You can access any of the memory areas, using the standard
S7/STEP 7 notation for entering the memory addresses.

This appendix provides descriptions of the memory areas, accumulators, and
address registers. It also provides a quick reference for the different formats
for displaying or modifying the data.

Section Description Page
B.1 Memory Areas for the S7-300 and S7-400 CPUs
B.2 S7-PLCSIM Notation for Entering Data

PLC Simulation for S7-300 and S7-400

C79000-G7076-C201-01
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S7 Reference Information

B.1 Memory Areas for the S7-300 and S7-400 CPUs

Figure B-1 shows the memory areas, accumulators, address registers, and the
status word for the S7-300 and S7-400 CPUs. S7-PLCSIM uses the view

objects to access the values stored in the simulated CPU.

Table B-1 describes the different memory areas.

CPU Accumulators and Registers
Accumulators 32 bits

Accumulator 1 (ACCU 1)

Accumulator 2 (ACCU 2)

Accumulator 3 (ACCU 3) S7-400 only |
Accumulator 4 (ACCU 4) S7-400 only |

Address Registers 32 bits

Address Register 1  (AR1) |

Address Register 2 (AR2) |

Data Block Registers 32 bits

DB number for the open DB |

DB number for the open instance DB (DI) |

Status Word
| Status bits 16 bits

Memory Areas

Peripheral I/0 PI, PQ
Outputs Q
Inputs |

Bit Memory M
Timers T
Counters C

Executable user program:
* Logic blocks
¢ Data blocks

Local data for the current block

Figure B-1 Memory Areas for the S7-300 and S7-400 CPUs

B-2
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S7 Reference Information

Table B-1  Memory Areas for the S7-300 and S7-400 CPUs
Name Memory Area Function of Memory Area
Input (1) Process-image | At the beginning of the scan cycle, the operating system reads the inputs
input table from the process and records the values in this table. The program uses these

values in its normal processing.
For every CPU cycle, Input memory stores the state of the inputs in the
process-image input table. The process-image input table maps the fifst 512
bytes of the peripheral input memory.

Output (Q) Process-image | During the scan cycle, the program calculates output values and placgs them

output table in this table. At the end of the scan cycle, the operating system reads|the
calculated output values from this table and sends them to the procegs
outputs.
The process-image output table maps the first 512 bytes of the peripheral
output memory.

Bit memory (M) | Memory bits This area provides storage for interim results calculated in the program. You
designate whether the data are to be accessed as bits, bytes, words, |etc.

Peripheral input | 1/O: Peripheral memory allows direct access to the field devices (physical| or

(PI) external inputs | external, inputs and outputs).

Peripheral output| I/O: Peripheral memory can be accessed in byte, word, and double-word format,

(PQ) external outputs | but not as bits.

Timer (T) Timer This area provides storage for timer cells. Clock timing accesses the {ime
cells in this area to update them by decrementing the time value. Timer
instructions access the time cells here.

Counter (C) Counter This area provides storage for counters. Counter instructions access them
here.

Data block (DB) | Part of the DBs store the information for the program.

program

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01
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S7 Reference Information

B.2 S7-PLCSIM Notation for Entering Data

B-4

The “Variables” view object provides a variety of formats for displaying or
entering the data in your program. The formats allowed are determined by
the size entered with the address: byte (B), word (W), or double word (D).
Table B-2 lists the formats that are available.

Table B-2 Data Formats for the “Variables” View Object

Data Format Size Example
Bits B E = off @ =on
Binary B and W 10010011
Decimal B, W, and D 232
Hex (hexadecimal) B, W, and D 9A
S7 Format B, W, and D D#16#09A2FF23
Integer W and D 623, —2370
BCD (binary-coded decimal) W and D 400
Real D —2134.232323

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01



Index

A
Accessible nodes

location of butt02

viewing the simulated PLCs, 3-2
Accessing the CPU memory argas| 4-4
AccumulatorZ

Address registers (AR1 and ARR), 4-7, B-2
Addresses, symbolic or absolyte,|4-6
Assistance, technical|iv
Authorization 1-4[ 1{7

original disk,

transfer
AUTHORS.EXE[1-b

B

BCD (binary-coded decimal), format, B-4
Binary data, forma4

Bit memory area of memory, descriptipn, B-2
Blocks, FBs, FCs, DBs, OBs, 1-3

C

Changing the CPU operating mo4-3
Changing the node address, turning the power
off, B-4
Closing the simulated PLE, 3-7
Continuous scaf, 3-4
Controlling the execution of a program,
simulator option4
Copy-protection] 114
Counters, accessing counter data), 4-4
CPU
areas of memory, B-2
changing operating modgs, 4-3
cycling power
disconnect STEP 7 tools before clos 3-6
downloading a prograrh, 3-3
indicators[ 4
memory areas$, 4-4
memory reset (MRES), 4-3
opening a CPU view objet, 3-7
operating modes$, 4-3

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01

CPU,continued
resetting the memory (MRE$), #-3
using a variable tabl —6
CPU scan
continuous scaf, 3-4
single scan mode, 3-4

Creating view objects, 4+-5
Cycling power

D
Data block (DB)[ 448

description as area of memdry, B-2
Data formats, Bl4

Decimal data, format, Bl4

Diagnostic informatior], 1}3

Differences between simulated and real PLCs,
i3

Disconnecting STEP 7 tools before closing

CPU,[3-6
Downloading a program, 3-3
selecting the simulatqr, 3-2

E

Entering datd, B4
Errors, during installatiof, 17
Execution control, selecting type pf, B-4

Exiting the applicatior], 3}7

F
Features supporteld, 1[2, 1-3

Halting the program
effect of Pause on STEP 7 todls,|3-6
Pausd, 34
Hardware requirements, 1-1
Hexadecimal data, format, B-4
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Index

I/0O memory supporte@—B
Input area of memory, descriptign, B-2
Inputs

setting bits] 24, 415

turning on and off, 414
Installation

error,[1-

overview[1-1

requirements, 1}1
Installing, PLCSIM| 1-6
Integer, format, B{4

L
L Stack, description of temporary local memory,

Z]
Ladder logic program, monitoring stat2-7
Layout of view objects, saving, 2-5
LEDs (status indicator: -2
Logic blocks supported, 1-3

M

Manuals, STEP 7 set, ifiHiv

Master control relaySeeMCR stack

MCR stack[ 34, 4]9

Memory areas, 4-4

Memory bits supported, 1-3

Memory requirement5, 1-1

Memory reset (MRES), 4-3

Modes, changing CPU operatipn, [4-3

Monitoring and modifying datg, 4-4

Monitoring and modifying the program
using a variable tablg, 26, 3-6
using view objects, 2-4-2-5, 3-5

MPI addressSeeNode address

MRES.SeeMemory reset (MRES)

N
Nesting stac@-g

Node address
only one PLC at a timg, 3-7
turning the power off before changifg,|3-4

O

Opening a layouf, 2}5
Opening a PLd, 3}7

Index-2

Operating modes, changing C4—3
Operating system requiremel-l
Options, simulatior], 314
Organization blocks (OBs) support 1-3
Output area of memory, descriptipn, B-2
Outputs, accessing Q and PQ memory, 4-4
Overview

installation| 1-f

product feature§, 1-2

P

Pause functio, 3+4
with STEP 7 toold, 3}6

Peripheral input and output areas of memory
accessin

description| B-2
PLC

closing] 3-7
opening
saving configuratior], 3}7
PLCSIM
errors during installatio@-?
Installation| 1-b
Power on/off
CPU indicator] 4J2
cycling power| 3-4
Product overview, 1/2
Program editor
downloading a prograrh, 3-3
monitoring statug, 217

R

Real number, format, B-4
Requirements, for installing PLCSIM, 1-1
Resetting the CPU memofy, 4-3
Resetting timer$, 215
RUN mode
changing the CPU mode f{o, 4#-2
CPU indicator| 442
Running a program, 2-@-5
RUN-P mode, changing the CPU modd to] 4-2

S

S7 format| B4

Sample program, running, 2{4-p-5
Saving

a layout of view object$, 3-5
the PLC configuratior], 37
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Scan mode$, 34
Showing symbol namds, 4-6
SIMATIC Manager

downloading a progr—3

selecting the simulatgr, 3-2
Simulation session, turning on and3-2
Simulator button, SIMATIC Manager, 3-2
Simulator options

continuous scah, 3-4

Pause] 314
single scan m%A

Single scan mode, 3-4

Stacks| 375, 419

Starting the prograrh, 3-4

Status indicators (LEDS), 4-2

Status Wor7

STEP 7 manuals, iiEiv

STEP 7 tools
disconnect before closing C—6
monitoring logic execution, 2-7
variable table (VAT)| 2-4, 36

STOP mode
changing the CPU mode fo, #-2
CPU indicator| 492

Stop mode, before resetting CPU memory
(MRES)[4-3

Symbol names for addresses4-6

System fault (SF), CPU indicator, #-2
System functions (SFCs) supported) 1-3

T

Technical assistande] iv
Timer area of memory, descriptign, B-2

PLC Simulation for S7-300 and S7-400
C79000-G7076-C201-01

Timers
accessing timer dafa, -4
creating[ 2-8
execution timed, 1}3
resettingS

Toolbar buttons
in PLCSIM window] 2-4l 34, 3
in SIMATIC Manager] 2-f, 3}2

U

Uninstalling, PLCSIM)} 16
Using STEP 7 tools, 2-6—2-7

\Y

Variable table, monitoring and modifying the

program| 2-5, 316
Variables, modifying datE-S

Variables view object, data form—4

VAT. SeeVariable table
View object

accessing data in memory, 4F414-5

accumulators, 35
block registerq, 3|5
CPU,[3-7[4-P
saving the PLd, 3]7
stacks| 344, 419
variable| 3-5

W
Windows 95 operating systef, J1-1
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Siemens AG
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Ostliche Rheinbriickenstr. 50
D-76181 Karlsruhe
Federal Republic of Germany

From:

Your Name:

Your Title:

Company Name:
Street:

Country:
Phone:

Please check any industry that applies to you:

Automotive Pharmaceutical

Chemical Plastic
Electrical Machinery
Food

Instrument and Control

Pulp and Paper
Textiles
Transportation

O O00ogoogod

Nonelectrical Machinery

OoOoo0ooOooQooad

Petrochemical
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Remarks Form

Your comments and recommendations will help us to improve the quality and usefulness
of our publications. Please take the first available opportunity to fill out this questionnaire
and return it to Siemens.

Please give each of the following questions your own personal mark within the range
from 1 (very good) to 5 (poor).

Do the contents meet your requirements?

Is the information you need easy to find?

Is the text easy to understand?

Does the level of technical detail meet your requirements?

Himnnn

ok wn

Please rate the quality of the graphics/tables:

Additional comments:
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